
The GPG - WinPRO Application Builder

Introduction:

The WinPRO Application Builder allows a user to enter a control graphic diagram into GPG and then process the drawing 
into a WinPRO application for the Johnson Controls Inc. WinPRO/HVACPRO configuration tool. The user can then go to 
HVACPRO and select the GPG application for configuring an ASC device. The configuration produced from the GPG 
application can then be used just as any standard WinPRO application configuration. It can be downloaded into a VAV, 
UNT, or AHU controller so long as the particular device selected supports the point types and numbers needed by the 
application. The ASC can then be commissioned as usual. The *.DDL, *.CFG, *.PRN, *.LST, and *.ASC files are created 
as usual. The WinPRO Application Builder also allows adding GPG generated control processes to standard WinPRO 
configuration files. This allows the user to produce most the the application using the standard Q&A but add special stuff 
with GPG. This provides more capability for non-standard applications than the WinPRO "side loop".

This Application Builder eliminates the application limitations of the ASC devices by allowing users to program the ASCs to 
do anything using the available functions. You are no longer limited to the choices provided by the standard applications in 
WinPRO. In fact with this GPG application the ASCs are now AFCs,  Application Flexible Controllers. The names, VAV, 
UNT, and AHU don't mean anything anymore. These controllers can just as well be called hot water system controllers, 
process controllers or whatever. They can now be used in applications where you might have previously used a DX9100 or 
an NCM with DCMs and XMs. This can be a substantial cost savings in many applications. Applications you couldn't do 
before because of programming limitations or cost constraints are now possible. 

Installation:

The WinPRO Application Builder is packaged in the APPMAKER setup files. APPMAKER includes the functions for 
building full WinPRO applications, doing Add-ons to standard WinPRO applications and Restoring previous GPG 
generated WinPRO applications into WinPRO. ARSU, the Add-on, Restore, Save Utility, includes the functions for doing 
add-ons to standard WinPRO applications and Restoring GPG/APPMAKER generated full WinPRO applications into 
WinPRO but can't produce full WinPRO applications. APPMAKER takes about 18 MB but ARSU only requires 4MB. Install 
one or the other but not both. Both are on the CD. The APPMAKER CAB file includes the standard symbol sets, attribute 
files and the APPMAKER application program. The ARSU CAB includes the standard symbol sets, attribute files and the 
ARSU program. 

Install Graphic Program Generator first. Use Windows Explorer to go to GPSPACKAGE folder on the CD. Double-click to 
open the folder. Double-click on setup.exe and follow the instructions. The setup program will create C:\GPG on your 
computer and load the program there unless you designate another location.

(Optional-Symbol Packer)
Install Symbol Packer next. The Symbol Packer program is used to add or remove symbols, *.bmp files, to/from the 
symbol set files used with GPG. If you don't plan on creating your own new symbols and functions you do not need to 
install the program. To install it use Windows Explorer to go to SYMPACKAGE folder on the CD. Double-click to open the 
folder. Double-click on setup.exe and follow the instructions. The setup program will create C:\GPG\SYMPACK on your 
computer and load the program there unless you designate another location.

Install APPMAKER next if you want to be able to produce full WinPRO applications using GPG. If ARSU provides the 
functions you need skip the APPMAKER install.

APPMAKER uses Windows DataAccess components. Setup for Data Access Applications May Fail if DCOM for Windows 
95 and Windows 98 isn't present on Windows 9x client machines. DCOM98.EXE is included on the CD. DCOM98.EXE is 
a self-extracting executable file that installs the DCOM components for Windows 95 or Windows 98.

Use Windows Explorer to go to APPPACKAGE folder on the CD. Double-click to open the folder. Double-click on 
setup.exe and follow the instructions. The setup will create C:\GPG\CONTROL\WINPRO on your computer and load the 
program there with all the support files unless you designate another location.

(Optional-ARSU)
If you did not install APPMAKER install the ADDON-RESTORE-SAVE Utility next. Use Windows Explorer to go to 
ARSPACKAGE folder on the CD. Double-click to open the folder. Double-click on setup.exe and follow the instructions. 
The setup program will load the program to C:\GPG\CONTROL\WINPRO unless you designate another location.



These programs can now be found in the Graphic Program Generator Group.

Run the WINPRO2.EXE self extracting file to install the example projects and the Library on to your computer. Run 
WINPRO2.EXE from Windows Explorer by double-clicking on it. The extractor dialog box will appear. Click on Recreate 
Directories then click on Extract. The directories will be created and the files extracted.

The files in the self extractor are also available on the CD in the WINPRO directory. You can optionally copy the example 
and library directories to your C:\GPG\CONTROL\WINPRO directory. This will create subdirectories including sample 
projects and the Library directory. Make sure that all files have their READONLY attribute turned off. If you use the self-
extractor you do not need to do this copying.

If you are going to use APPMAKER, after installation make a backup copy of your C:\WINPRO\DATA\APPS.DBF file. 
Copy the contents of the C:\GPG\CONTROL\WINPRO\DATA directory to your C:\WINPRO\DATA directory.

The main executable file for GPG is GPS.EXE which is installed from its setup files into the C:\GPG directory or the 
directory you select. You may want to add this to your WinPRO Configuration Tools Group. Click on Start, move over 
Programs, move to Configuration Tools and right click. Click Open. Click on File- New- Shortcut and browse to your 
GPG.EXE file. Enter the command line: C:\GPG\GPS.EXE X C:\GPG\CONTROL\WINPRO. The working directory is C:
\GPG. Enter your description, Graphic Program Generator. You can also create a shortcut for the Graphic Program 
Generator on you desktop by right clicking on the screen and clicking on New - Shortcut and setting it up as above. 

**** ATTENTION **** If your computer doesn't have WINPRO in the C:\WINPRO directory edit the GPG.INI file, found in
C:\GPG\CONTROL\WINPRO, so that GPG can find it. Change the directory on the INI2=C:\WINPRO line.  If you don't 
want to install GPG on your C: drive or you wish to put it in a different directory you will have to edit all the lines which refer 
to C:\GPG in the GPG.INI file. Modify the installation routine above to have the desired directories.

Run the example projects to test your configuration. Startup GPG.EXE from the shortcut. Click File, Load Drawing and 
select the HWCON2 directory and HWCON2.GPG drawing file. Double-click on the drawing file or single-click it and then 
click Open. The drawing will draw on the drawing area. Click Process,Limit Questions. Click Process, Process All, and the 
Process dialog box will appear and the drawing will be scanned three times. The GPG WinPRO Application Builder 
defaults to WinPRO Application number 200 in the APPS.DBF database. If that application number is already used 
processing will fail. Near the end of processing the process dialog box will display a message, 'Running AppMaker'. Watch 
for an 'Attention' message box 'Select an unused APPNUM'. If this happens edit your APPSDEF.TXT file in the
C:\GPG\CONTROL\WINPRO directory. Change 200 to 220 or another unused number. Save the file and try processing 
the drawing again.

After processing the Process dialog box will show,

"Processing Successfully Completed"
"Click OK to continue"

then click ok. The HWCON2 application will now be available in HVACPRO. Startup HVACPRO and click on File, New and 
scroll down the application groups to GPG Graphic Program. Select it then select the drawing. There is one question, 
"Continue", enter yes. 'Save As' the application as a UNT141-1 or another allowed device in the HWCON2 directory with 
HWCON2.CFG as the name. The application should save with no problems. It can now be loaded into a ASC controller 
just as any other WinPRO/HVACPRO application.

Read the help files available from the help menu in GPG or using notepad to access the GENERAL.TXT, SYSTEM.TXT, 
FILES.TXT, ATTR.TXT or USER.TXT files in the C:\GPG directory.

Notes on the ASC Controllers and using the GPG- WinPRO Application Builder:

The ASC Controllers execute their program on a cyclic basis every 1.5 seconds. This period is called a Tic. At the 
beginning of the cycle the AI points and BI points are scanned. Then the program is executed. And finally the outputs 
receive the commands generated during the program execution. Most timing in the ASCs is based on the Tic. The basic 
delay function uses the Tic as its unit of time.

When GPG assembles the program for the ASC from a drawing it scans the drawing like a TV raster. Left to Right then 
down to the next row. (Always use the HORIZONTAL scan direction with this GPG application) Actually this GPG 
application uses three scans. The first one identifies all the connections on the drawing. The second scan defines the 



hardware points and the parameters. The third scan produces the program code. The code is assembled in the order in 
which the functions are scanned. This is the order in which the functions are stacked in the program and the order in which 
they execute in the ASC. This can be important for controlling execution order and can be used to do some neat 
programming tricks.
Look at the example below. The OR function would execute first. Then the AND function and then the NOT. The result is 
that the NOT value is delayed one cycle (Tic=1.5 seconds) relative to the OR value. In most applications this might not 
matter but sometimes it does.

To have both values seen by the AND gate on the same cycle rearrange the drawing as shown 
here.

Now the OR function executes first. The NOT function executes second and the AND 
function is last.

Below is an example of a trick. This circuit functions as a positive edge detector. When the binary input turns on the AND 
gate output is pulsed on for one cycle then it goes back off. This works because of the NOT function value being delayed 
one cycle by its placement on the drawing relative to the AND function. 

This sensitivity to drawing location is only true of functions. Points can be anywhere 
on the drawing and it won't matter. All the inputs are read at the beginning of the cycle before the functions are calculated. 
All the outputs are done at the end of the cycle after all the functions are calculated. Parameters can also be anywhere on 
the drawing. The main concern with parameter location is that the order in which they are scanned is the order that the 
numbers are assigned. If you add parameters to a previously mapped GPG application, add them below the existing 
parameters to avoid changing the parameter numbers.

Building Applications

The procedure to produce an application is to create a directory for the application's files, create the drawing and save it to 
the directory, and then process the drawing. Answers to questions asked during processing will be saved to the drawing's 
directory. All the files written to the WinPRO directories for the application will also be copied to the drawing directory. This 
makes it easy to distribute and archive the application. 

If you wish to commission or download an application after you've done other GPG - WinPRO applications, or using a 
different machine which may or may not have GPG you can use APPMAKER or ARSU (ADDON-RESTORE-SAVE Utility) 
to do the file copying. Enter the WinPro Path, c:\winpro, and the drawing path, c:\gpg\winpro\meter\, (note the ending 
backslash) then click Restore. ARSU doesn't have the database functions needed to produce a WinPRO/HVACPRO 
application but it takes much less space on a PC or laptop. Both APPMAKER and ARSU can be used to add processes, 
points and parameters to standard configurations using GPG.

For detailed general information on using GPG read the SYSTEM USAGE help file. This is available from within the GPG 
program using the Help menu item or from outside the program using a text editor such as notepad to view the file 
SYSTEM.TXT in the C:\GPG directory. 

The basic procedure to create an application is as follows:

(1.) Create a directory to save your application to using Windows Explorer or do it from within GPG on the next step.
(2.) Go to GPG.EXE (Click on your Graphic Program Generator item in Config Tools Group or your deasktop shortcut)  



Create the directory for the application and save the blanl new drawing. You can do this using the Save Drawing dialog 
window from the File menu in GPG. The folder symbol with the asterisk is for creating a new folder. Save the blank new 
drawing in the new directory with your new drawing name.
(3.) If the Symbol View Box isn't visible, click on the Options menu item

(a.) click on the Symbol View Box item to toggle it on.
(4.) To place a symbol on the drawing first click on the drawing at the location where you want it. If you have the screen in 
MAXIMIZED mode double-click to both select the location and bring the symbol view box back on top. Select your symbol 
by double-clicking on the one you want. Use the vertical scroll bar or horizontal scroll bar to see more symbols.
(5.) Most applications will have the APPSTART, PRCSTART,PRCEND, and APPEND symbols in the same place. 
APPSTART, the application start symbol, is always placed in the top left corner of the drawing. APPEND, the application 
end symbol, is always placed in the bottom most, right-most location. PRCSTART, the process start symbol, is usually 
placed just right of, and one row down from the APPSTART symbol. PRCEND, the process end symbol, is usually placed 
just left of, and one row up from the APPEND symbol.
(6.)The control diagram should then be drawn inside the box infered by the corners created with the PRCSTART and 
PRCEND symbols. The current symbol set encourages placement of inputs on the left side of the drawing, outputs on the 
right side of the drawing, and your processing logic in-between. Connections between symbols are done manually using 
the connector symbols. Select these symbols just as you select the others. See SYSTEM USAGE Help for more drawing 
functions like 'Repeat' which comes in handy for making long connections. See the Symbol Library below for information 
on how to use, and connect to the various points and functions.



**************************************************************************************************************
The user can switch between different symbol sets to change the size of the symbols used and the amount of the drawing 
that is visible at one time. Using smaller size symbols gives the user a "zoomed out" view and makes it easier to do large 
area moves and edits. To change to a different symbol set use the File menu item on the Symbol View Box. The symbol 
directory is selected using the File - Open menu item to open a file selection dialog box. The user can then select the 
drive, 
directory, and *.sif (symbol information file) filename to load. The file will load after entering the filename or clicking on 
Open.
The drawing will redraw using the newly selected symbol set. You can change the default symbol set by editing that item in 
your GPG.INI file in the C:\GPG\CONTROL\WINPRO directory. The symbol sets that work with this GPG application are 
sym5.sif (small), sym6.sif (large) and sym9.sif (medium). See FILES Help for more information.

SYMBOLFILE=C:\GPG\CONTROL\WINPRO\SYM5.SIF
CELLWIDTH=11
CELLHEIGHT=14

**************************************************************************************************************
When using a non-wired parameter you need to place the parameter's symbol someplace on the drawing so it is defined. 
Remember the LONG name you give the parameter during processing so you can identify it in the function. 
**************************************************************************************************************
You should not directly connect input points to output points or parameters directly to points. A function is needed to 
actually produce the code that sends a command to the point. For example you could use two NOT symbols or an OR 
symbol, or an AND symbol between a binary input and a binary output to make a simple interlock.
**************************************************************************************************************
Refer to the SYSTEM USAGE help file for information on editing the drawing. REPEAT, MOVE, ERASE, COPY, PASTE, 
etc. are some of the available functions.
When placing connector symbols its important to note that the function symbols are color coded for data type. Yellow 
functions are BINARY LOGIC functions. Green functions are FLOATING POINT functions. Cyan functions are INTEGER 
or TIME functions. TIME functions use special Integer values which are produced by WinPro during assembly. Yellow 
connections should be connected to yellow connections. Green connections should be connected to green connections 
and cyan connections to cyan connections. Functions like the Compare function have both green connections and yellow 
connections because they connect to more than one type of data. 
(7.) It is recommended that you place identifying text beneath(behind) the symbols that require answers for setup. This text 
will be used to name the answer storage files. The text will also be used to name some of the instance specific variables in 
the application. Click on the symbol then use the Text item under the Edit menu to do this. Use 6 character or less names. 
This text will also appear in the caption on the process dialog box during drawing processing and can be used to inform 
the user which symbol is being processed. You will be asked to enter the identifying text during processing if you haven't 
already done it. The text also appears on screen if you turn 'SHOW TEXT' on from the Options Menu Text item.
(8.) Save the drawing to the directory you created for the application. Click on the File menu then click on Save Drawing. 
Select the directory and enter the drawing name you want to use. The extension is always .gpg.
(9.) You can process one symbol at a time. This mode, available in the Process menu, allows entering the answers before 
you do Process All to produce the final files. Its convenient for doing small changes and for processing in a more relaxed 
mode. You don't feel so chained to the process. Also available is the Limit Questions process option. This allows you to 
process the drawing with only the un-answered questions being asked. This provides for fast re-processing of drawings. 
To complete the application production click on the Process menu then click on Process All. GPG will scan the drawing. 
When information is required the Process Dialog box will display questions. Enter the answers for your application. After 
the three scans GPG will run APPMAKER to produce the DBase files. The APPS.DBF will then be modified and the files 
copied to the directory you created for the application.
(10.) The WinPRO application has been created.  You can now go to WinPRO and select the GPG application for 
configuring an ASC. Click on NEW from the WinPRO File menu and select the GPG Graphic Program then select the 
drawing.

Take a look at C:\GPG\CONTROL\WINPRO\METER\GASMTR.GPG. It is an application for reading a slow pulsing gas 
meter by measuring the time between pulses instead of the pulses per minute. This example demonstrates some tricks. A 
MUX is used as a sample and hold and the location of the MUXs on the drawing (vertically) is used to control the order in 
which the MUX switches operate.

Adding GPG Processes to Standard Configuration Files

You can add GPG generated processes, points, and parameters to existing configuration files produced using standard 
WinPRO applications. This allows you to use the standard Q&A paths for a large portion of the application then add 
special stuff with GPG. The procedure is to create the standard WinPRO configuration file. Then create your GPG 
drawing. Leave off the APPSTART and APPEND symbols. When GPG processes the drawing it will notice this. When it 



processes the PRCSTART symbol it will ask for the filespec of the configuration file you want to add the GPG process to. 
Enter the filespec including the .cfg extension. GPG will assume the *.cfg file is in the drawing directory. The PRCEND 
symbol will control the creation of the modified version of the configuration file using APPMAKER or ARSU, the ADDON, 
RESTORE,SAVE Utility. The name of the new configuration file will be the first six characters from the original filename 
with _M appended to it. OPEN the modified configuration file in WinPRO and then SAVE it. Don't use SAVE AS, use 
SAVE. All the files (*.ddl, *.prn, *.asc, *.cfg, *.lst etc.) for the modified configuration will be created and will include the GPG 
added process. The configuration can now be used to configure and commission a controller as usual.

***** ATTENTION ***** When adding new points in the GPG-WinPRO add-on mode check the existing configuration to 
make sure you don't assign point numbers that are already used. Parameter numbers will be handled automatically by 
GPG. If a number is already used GPG will look for an unused number and use it. If none are available the user will be 
notified. The Special Point Symbol is used to access pre-existing points, parameters and results (wiring) in the WinPRO 
configuration. See it below.

Take a look at the C:\GPG\CONTROL\WINPRO\CHUDD\CHUDD2.GPG  GPG-WinPRO add-on example. This example 
adds a motion detector controlling the minimum damper position.



Notes

GPG is a product of SWFTEC. Its written by me, Stephen W. Frey. I can be reached via E-Mail at SWFTEC@AOL.COM. 
Business Phone Number is (937) 256-9698 (U.S. Eastern Time Zone). Web-Site is http://members.aol.com/swftec/ . If you 
have questions, comments, suggestions etc., don't hesitate to contact me.



The Symbol Library:

Program Assembly Control Symbols

Application Start Symbol                    APPSTART

The Application Start Symbol is used at the top left corner of the main drawing. It sets up all the files used during 
the processing of the drawing. Being in the top left corner it is always the first symbol processed. 

Application End Symbol                      APPEND

The Application End Symbol is used at the bottom right corner of the main drawing. It should be low enough and 
right enough on the drawing that all other symbols are above and to the left of it. This symbol closes out files, generates 
the Fall file, the Log file,  and calls APPMAKER to generate DBase data and index files. Being in the bottom right corner it 
is always the last symbol processed. 

Process Start Symbol                         PRCSTART

The Process Start Symbol is used at the top left corner of the area used on a drawing for a process. No symbols 
to be included in the process should be above or left of this symbol. This symbol keeps track of the process number and 
writes the symbol module header to the GPG.mod module file.
The Process Start symbol also sets up the files and asks for the configuration filename when it is used in the GPG-
WinPRO add-on mode. (see above) 

Process End Symbol                          PRCEND

The Process End Symbol is used at the bottom right corner of the area used on a drawing for a process. No 
symbols to be included in the process should be below or right of this symbol. This symbol writes the symbol module end 
character to the GPG.mod module file.
The Process End symbol controls creation of the modified configuration file using APPMAKER when it is used in the GPG-
WinPRO add-on mode. (see above) 



Control Diagram Symbols

Absolute Value Function                       ABS

The Absolute Value function takes a floating point value in at it's left connection and outputs the floating point 
absolute value to the connection at it's right.

Addition Function                                   ADD

The Addition function adds two floating point values from connectors to it's left and outputs the sum to the 
connector to it's right. It is always used with the two input symbol 'L2CON.BMP'. (see example below)



Analog Input Point                                 ANAIN

The Analog Input Symbol provides for configuring an analog input point and connecting it to the floating point 
functions in the control system. Questions will be asked during GPG processing to define the point. The name of the point 
is passed down the connector to the function so that the function can access the floating point value of the point. The 
connection is always done to the right side of the symbol. Connect to floating point functions.(green) The user can place 
point symbols on the drawing and not connect them. During processing the point will be defined as usual but it will be 
flagged as not being referenced in the logic. This is like a point defined in a generic I/O configuration or a point added 
during WinPRO configuration
.

Analog Output Point                               ANAOUT

The Analog Output Symbol provides for configuring an analog output point and connecting it to the functions of the 
control system. The name of the point is passed up the connector to the function which will command the point. Values 
sent to the output are from floating point type functions.(green) The connection is always done to the left side of the 
symbol. The user can place point symbols on the drawing and not connect them. During processing the point will be 
defined as usual but it will be flagged as not being referenced in the logic. This is like a point defined in a generic I/O 
configuration or a point added during WinPRO configuration.

And Logic Function                                   AND

The And Logic Function Symbol provides a logic AND function for two input values. When both binary inputs are 
'ON' or logic 1 the output is 'ON' or logic 1. Otherwise the output is 'OFF' or logic 0. It is always used with the two input 
symbol 'L2CON.BMP'. Inputs connect at the left and the logic output is provided at the right connector. Connect to BINARY 
type values(yellow).



Auto Zero Function                                 AUTOZERO

The Auto Zero Function Symbol provides an Auto Calibrating function primarily intended for use with the delta P 
transducers used to read the velocity pressure on VAV boxes. It adjust the AI offset of the sensor point to get zero reading 
when there is no flow. It supports only the four input symbol, 'L4CON.BMP', configuration. The example below shows the 
required connections. The calibration process consist of turning 'ON' the binary output for the Max Stroke time. This can 
be used to override the damper closed and/or turn off a fan. After the Max Stroke time the CFM should be zero. The output 
will stay 'ON' . The Auto Zero control will then adjust the AI offset of one or more sensor points. The user specifies, during 
processing of this symbol, the number of points and the 24 character long name(s) of  the AI point(s) defined for the 
pressure sensor point(s). This provides the connection to access the offset. The output will then turn back 'OFF' and the 
control will return to normal. The calibration process is activated whenever the Activate Command connection turns 'ON'. It 
is also activated one hour after the Occupied Status connection turns 'ON'. Once a hour the control checks if the Room 
temperature has changed more than five degrees since the last calibration. If it has, the calibration is done. Once an hour 
the control checks if the Actual CFM is less than 30% of the Max CFM. If it is the calibration is done. If the Occupied 
Status point doesn't change for 24 hours the calibration is done.



Average Function                                    AVERAGE

The Average Function Symbol provides a floating point average function. It supports the two input symbol, 
'L2CON.BMP', the three input symbol, 'L3CON.BMP',  the four input symbol, 'L4CON.BMP', and the five input symbol 
'L5CON.BMP. If any input is unreliable the average will be computed based on only the inputs that are reliable and the 
unreliable input will be ignored. Connect to FLOATING POINT values.(green) 

Binary Input Point                                  BININ

The Binary Input Point Symbol provides for configuring a binary input point and connecting it to the logic functions 
in the control diagram. Always make connection to the right side of the symbol. The name of the binary point is passed 
down the connector to the function so that it can access the value of the point. Always connect to BINARY functions.
(yellow) The user can place point symbols on the drawing and not connect them. During processing the point will be 
defined as usual but it will be flagged as not being referenced in the logic. This is like a point defined in a generic I/O 
configuration or a point added during WinPRO configuration.



Binary Multiplexer (Switch) Function  BINMUX

The Binary Multiplexer(Switch) Function Symbol provides a selection or switching function for binary logic values. It 
can select the value from one of the two inputs on it's left to be sent out on the connector to it's right. Always use the two 
input symbol, 'L2CON.BMP'. The switch is controlled by the logic connected using the top or bottom middle connections. 
This connection acts as a jump connector and can pass the switch control value through the MUX symbol in the vertical 
direction. A 'ON' or '1' condition selects the top left input and a 'OFF' or '0' value selects the bottom left input. Don't place a 
connector symbol immediately above or below this symbol if you don't intend to connect to the control connection.

Binary Output Point                              BINOUT

The Binary Output Point Symbol provides for configuring single maintained or momentary binary outputs and 
connecting them to their controlling logic. Maintained type binary outputs require one BO hardware point. Momentary type 
binary outputs require two consecutive BO hardware points. One for start and one for stop. During GPG processing the 
user can select either slow 1.5 second pulses or fast 50 millisecond pulses for momentary points and many other 
parameters such as the minimum on time. Always connect to Binary functions.(yellow) 

Binary Parameter                               BINPARM

The Binary Parameter Symbol provides for configuring and connecting a binary parameter. This is a BD point in 
Metasys terms. These parameters are used with the logic functions. These parameters can be referenced within other 
functions by long name or can be connected (wired) into the control system. Connections can be made to the left or right 
sides using any of the "connector" symbols. Place a real connector between this symbol and function symbols to make a 
connection. Do not connect directly to point symbols or other parameter symbols. To pass the value a function must be 
used.



Binary Sequence (Multi-Stage Binary Output) Function/Points  BINSEQ and BSEQC06

The Binary Sequence Function Symbol provides for setting up a multi-stage binary output. The 
number of stages is selected during GPG processing. The first BO point is designated and the rest are consecutive points. 
The pseudo analog point which receives the command and the binary output points are all configured by this symbol 
during processing. Notice that this symbol is green. It receives it's command as a floating point value input at the 
connection to it's left. A binary "Instant Off" command can be connected to the top or bottom yellow connections. This will 
shutdown all the outputs immediately with no interstage, or minimum on time delays. The symbol allows the user to specify 
interstage delays, minimum on time, and minimum off time delays. Also rotating sequence can be selected to have the first 
stage point rotate to a different BO each time the staging sequence starts. An analog venier point can be connected at the 
right side of the symbol. This point will be ramped from 0 to 100 % between stages. The staging levels are determined by 
the number of stages. The level spacing is calculated from 100%/(number of stages). The first stage level can be 
individually set. The rotating sequence option is not available if you use the venier point. The First stage level may not be 
set if the venier point is used. When using the vernier point always place the analog output symbol right next to the binary 
sequencer symbol. The BSEQC06 Symbol should be used for this function in AHU controllers rev. C06 and newer.

CFM Calculation (Velocity Pressure to CFM) Function  CFMCALC

The CFM Calculation Function Symbol is provided to calculate the cfm from a velocity pressure input. The vp 
differential pressure input point is connected at the left and the cfm is output at the right. These are all floating point values
(green). The area and K factor can be either constants or parameters and are determined during GPG processing of the 
symbol.



Compare (Floating Point Comparision with differential)  COMPARE

The Compare Function Symbol provides for a floating point comparision with differential function. It is used with the 
two input symbol, 'L2CON.BMP' or the three input symbol, 'L3CON.BMP'. If the value from the top left connection is 
greater than the value from the bottom left connection the binary output provided at the right connection will be 'ON' or a 
'1' value. Once the output is 'ON' the top left value must be the differential value below the bottom left value to turn the 
output back 'OFF.' The center left connection of the three input symbol is used to connect to the differential value. A 
constant, parameter, or a value from another floating point function can be connected here. If the two input symbol is used 
the differential can be a constant or a parameter. This is determined during GPG processing of the compare symbol. To 
use a parameter you must place the parameter's symbol someplace on the drawing and remember the name you gave it 
during processing so you can identify it to the function.

Constant                                            CONSTANT

The Constant Value Source Symbol provides for connecting a constant value to functions. The type of function 
depends on the type of constant. During GPG processing the user can select Floating point, Integer or Binary data type 
and enter the value. 

Delay (Time delay) Function                DELAY

The Delay function provides a binary 'ON' and/or 'OFF' delay. The binary input is connected at the left connection 
and the binary output is at the right connection. During GPG processing the 'ON' and/or 'OFF' delay functions can be 
selected and values and sources for the delays and delay counters can be designated. The top and bottom integer (cyan) 
connections are user determined. Time delay values are entered in Tics. Each ASC processor Tic is 1.5 seconds. Minutes 
can be converted to Tics using the circuit shown below right. The delay in minutes comes from a floating point source, 
(parameter, analog point, functions etc.), is multiplied times 40 tics per minute and then converted to an integer and 
connected to the delay function.  

Division Function                                 DIV

The Division function divides the floating point value from it's top left connection by the floating point value from it's 
bottom left connection and outputs the result on the connector to it's right. It is always used with the two input symbol 
'L2CON.BMP'. (see example below)



Enthalpy Function                              ENTHALPY

The Enthalpy Function calculates enthalpy using a temperature input and a relative humidity input. The 
L2CON.BMP two input symbol is always used at the left of the symbol. The floating point temperature value is connected 
at the top left and the floating point relative humidity value is connected at the bottom left connection. The floating point 
enthalpy value is output at the right connection. English or Metric units can be selected during GPG processing.

Failsoft Function                                  FAILSOFT

The Failsoft Function monitors the reliability of the value connected at its right. If the value is reliable it is output at 
the right connection. If the input value is unreliable a default value is output at the right connection. If one input is used the 
default can be a constant or a changeable parameter. To use a parameter you must place the parameter's symbol 
someplace on the drawing and remember the name you gave it. If the L2CON.BMP two input symbol is used the input 
value is connected at the top left and the default value source is connected at the bottom left.



Float to Integer Conversion Function   FLTINT

The Float to Integer Conversion Function converts a floating point value connected on its left to an integer value in 
the range 0 to 32767 and outputs this value on the connector to its right.

Float Parameter                                  FLTPARM

The Float Parameter Symbol provides for configuring and connecting a floating point parameter.  This is an AD 
point in Metasys terms. These parameters can be referenced within other functions by long name or can be connected 
(wired) into the control system. Connections can be made to the left or right sides using any of the "connector" symbols. 
Place a real connector between this symbol and function symbols to make a connection. Do not connect directly to point 
symbols or other parameter symbols. To pass the value a function must be used.

Incremental Control with Feedback      INCWFB

The Incremental Control with Feedback Point provides for configuring an incremental control using two binary 
outputs, a psuedo analog point, and a source for a feedback signal. The psuedo analog and binary outputs are configured 
within this symbol during GPG processing. The feedback point is a floating point type and is defined separately. The 
setpoint input is connected to a floating point function which will command the incremental output. During GPG processing 
the user can specify the deadband and the failsoft command, which is the direction that the incremental output runs when 
an input is unreliable. The open and close connections are optional binary inputs for overriding the actuator to run in the 
specified direction. An 'ON' or logic 1 condition enables the override.



Incremental Control without Feedback INCWOFB

The Incremental Control without Feedback Point provides for configuring an incremental control using two binary 
outputs, and a psuedo analog point. The psuedo analog and binary outputs are configured within this symbol during GPG 
processing. The feedback is generated internally by the control using the stroke time of the actuator. It is available at the 
feedback output connections shown below. The setpoint input is connected to a floating point function that will command 
the incremental output. During GPG processing the user can specify the stroke time, the deadband and the failsoft 
command, which is the direction that the incremental output runs when an input is unreliable. Most parameters can 
optionally be wire connected depending on the input configuration used.(see below) Stroke time is an integer and is in 
TICs (1.5 sec. unit). Restart, Open and Close are  binaries and the rest are floats. When the restart input is forced to zero, 
'OFF', this will run the output in the failsoft direction for long enough to ensure that the actuator has gone the full stroke in 
that direction. This is used to initialize the actuator at a known position so that the stroke timing method of position 
determination can work. It is not neccessary to connect this input if you only want to initialize the actuator at controller 
reset. It will do that anyway. The open and close connections are optional binary inputs for overriding the actuator to run in 
the specified direction. An 'ON' or logic 1 condition enables the override.

Integer Parameter                              INTPARM

The Integer Parameter Symbol provides for configuring and connecting an integer parameter. Integers can be in 
the range 0 to 32767. These parameters are usually used for the time functions and delay functions. These parameters 
can be referenced within other functions by name or can be connected (wired) into the control system. Connections can be 
made to the left or right sides using any of the "connector" symbols. Place a real connector between this symbol and 
function symbols to make a connection. Do not connect directly to point symbols or other parameter symbols. To pass the 
value a function must be used.



Maximum Signal Selector                  MAXSEL

The Maximum Signal Selector Function Symbol provides a floating point function to select the highest value from a 
number of inputs. It supports the two input symbol, 'L2CON.BMP', the three input symbol, 'L3CON.BMP',  the four input 
symbol, 'L4CON.BMP', and the five input symbol 'L5CON.BMP. If any input is unreliable the maximum (highest) value will 
be selected based on only the inputs that are reliable and the unreliable input will be ignored. Connect to FLOATING 
POINT values.(green) 

Minimum Signal Selector                      MINSEL

The Minimum Signal Selector Function Symbol provides a floating point function to select the lowest value from a 
number of inputs. It supports the two input symbol, 'L2CON.BMP', the three input symbol, 'L3CON.BMP',  the four input 
symbol, 'L4CON.BMP', and the five input symbol 'L5CON.BMP. If any input is unreliable the minimum (lowest) value will be 
selected based on only the inputs that are reliable and the unreliable input will be ignored. Connect to FLOATING POINT 
values.(green) 



Multiplication Function                             MULT

The Multiplication function multiplies two floating point values from connectors to it's left and outputs the product on 
the connector to it's right. It is always used with the two input symbol 'L2CON.BMP'. (see example below)

Floating Point Multiplexer (Analog Switch) MUX

The Floating Point Multiplexer(Switch) Function Symbol provides a selection or switching function for Floating Point 
values (green). It can select the value from one of the two inputs on it's left to be sent out on the connector to it's right. 
Always use the two input symbol, 'L2CON.BMP'. The switch is controlled by the logic (yellow) connected using the top or 
bottom middle connections. This connection acts as a jump connector and can pass the switch control value through the 
MUX symbol in the vertical direction. An 'ON' or '1' condition selects the top left input and an 'OFF' or '0' value selects the 
bottom left input. Don't place a connector symbol immediately above or below this symbol if you don't intend to connect to 
the control connection.

N2 Bus Communications Status Point    N2COM

The N2 Bus Communication Status symbol provides a logic point to provide N2 bus status. If the N2 Bus is 
communicating the function receiving a connection from this symbol will get an 'ON' or logic 1. If the bus isn't 
communicating the function will get an 'OFF' or logic 0.



Negative Comparision                         NEGCMP

The Negative Compare Function Symbol provides for a floating point comparision with differential function. It is 
used with the two input symbol, 'L2CON.BMP' or the three input symbol, 'L3CON.BMP'. If the value from the top left 
connection is less than the value from the bottom left connection the binary output provided at the right connection will be 
'ON' or a '1' value. Once the output is 'ON' the top left value must be the differential value above the bottom left value to 
turn the output back 'OFF.' The center left connection of the three input symbol is used to connect to the differential value. 
A constant, parameter, or a value from another floating point function can be connected here. If the two input symbol is 
used the differential can be a constant or a parameter. This is determined during GPG processing of the compare symbol. 
To use a non-wired parameter you must place the parameter's symbol someplace on the drawing and remember the 
name you gave it so it can be identified to this function.

Not Logic Function                                    NOT

The Not Logic Function Symbol provides a logic NOT or inversion function for one input value. If the binary input 
connected at the left is 'ON' or logic 1 then the binary output connected at the right is 'OFF' or logic 0. If the input is 'OFF' 
or logic 0 then the output is 'ON' or logic 1. Connect to BINARY type values.(yellow)

Or Logic Function                                     OR

The OR Logic Function Symbol provides a logic OR function for two input values. When either of the  binary inputs 
are 'ON' or logic 1 the output is 'ON' or logic 1. If both inputs are 'OFF' or logic 0 the output is 'OFF' or logic 0. It is always 
used with the two input symbol 'L2CON.BMP'. Inputs connect at the left and the logic output is provided at the right 
connector. Connect to BINARY type values.(yellow)



Ramp Function                                        RAMP

The Ramp Function Symbol provides a Ramp function. This is usually used to limit the response of the control 
during the initial startup. The input is connected at the left. The output connected at the right will track the input in 
incremental steps over time. Fast and slow step sizes are selected during GPG processing and can be either constants or 
changeable parameters. The parameter's symbol must be on the drawing someplace and you must know the name you 
gave it. When the output is near zero, the slow step size is used to increment the output every 1.5 seconds until it reaches 
the input value. The step flag output is available at the bottom yellow connection. During the time the slow step is being 
used the step flag will be set to 'ON' or 1. When the output becomes greater or equal to the input, the fast step increment 
is used and the step flag is set to 'OFF' or 0. Anytime the difference between the input and the output is less than than 
current step size the output will be exactly equal to the input. Anytime the output gets near zero (below 0.001), the step 
size will change back to the slow step size. The step size change feature can be disabled by just making both step sizes 
the same.

Reset Function                                         RESET

The Reset Function Symbol provides a Proportion only type control function. It is usually used as a setpoint reset 
function but can be used as a proportional only control. It is used with one input or the three input symbol, L3CON.BMP. 
The allowed configurations are shown below. In the one input configuration any connector symbol ,any floating point 
function or an analog input symbol can be used in the left location. When the L3CON.BMP symbol is used all parameters 
are wired. When one input is used all the parameters can be either constants or changeable parameters. These are 
determined during GPG processing. To use a parameter here you must have placed the parameter's symbol someplace 
on the drawing. Remember the long name you gave it during the first processing pass. As the input value varies from the 
input setpoint to the input setpoint plus the input propband, the output varies from the output setpoint to the output setpoint 
plus the output propband. The output is limited to the range from output setpoint to output setpoint plus output propband.



Single Proportional plus Integral Controller SGLPI

The Single Proportional plus Integral Controller Symbol provides a PI type control function. It is used with the two 
input symbol, L2CON.BMP, the three input symbol, L3CON.BMP, the four input symbol, L4CON.BMP, or the five input 
symbol, L5CON.BMP. The feedback is always connected to the closest left top connection and the setpoint is always 
connected to the closest bottom left connection. The other connections are all optional and determined by the user during 
GPG processing of the symbol. The Proportional Band, Integral Gain, Deadband, Bias and Integral term can all be set up 
to be accessable through connections, be constants, or be changable parameters. To use a parameter here you must 
have placed the symbol for the parameter someplace on the drawing. GPG will ask for the LONG name of the parameter 
to identify it. All these parameters are the floating point type. GPG will provide parameter name defaults based on the text 
label beneath(behind) the SPI symbol and PB, DB, IG, BI, or IT. For example if you named the SPI control PI1, the 
propband default parameter name would be PI1PB. If you use these names for your parameters you'll save some effort. If 
the Integral Gain value is set to zero the Integral term value will be zeroed too. This can be used to initialize the integral 
term at process startup or while the unit is off. A zero Integral Gain will basically disable the integral function. Otherwise a 
small integral gain yields a fast ramp and a large integral gain yields a slow ramp.

Single Proportional plus Integral and Derivative PID

The Single Proportional plus Integral and Derivative Controller Symbol provides a PID type control function. It is 
used with the two input symbol, L2CON.BMP, the three input symbol, L3CON.BMP, the four input symbol, L4CON.BMP, or 
the five input symbol, L5CON.BMP. The feedback is always connected to the closest left top connection and the setpoint is 
always connected to the closest bottom left connection. The other connections are all optional and determined by the user 
during GPG processing of the symbol. The Proportional Band, Integral Gain, Deadband, Bias, Integral Term, and 
Derivative Weight can all be set up to be accessable through connections, be constants, or be changable parameters. 
(see Single PI symbol above for connection examples)



Span Function                                         SPAN

The Span Function symbol provides a span function to calculate a reset setpoint similar to the DSC-8500 CAL1 
Span function. As the value at the Input connection varies from Low Input to High Input the Output will vary from Out 1 to 
Out 2. The Output will not go higher than the highest of Out 1 and Out 2 or lower than the lowest of Out 1 and Out 2. Low 
Input and High Input must not be the same value. The Low Input must be lower than the High Input. Out 1 and Out 2 can 
be the same value. The value of Out 1 can be either greater than or less than the value of Out 2. The symbol can be used 
with one input or with the three input symbol and the two out 'n' connections as shown below. When one input is used the 
High Input, Low Input, Out 2, and Out 1 values are selected during GPG processing and can be constants or parameters. 
The Span function is also valuable for doing feedforward calculations and can also be used for segmented curves by 
connecting several together.

Special Point                                         SPECIAL

The Special Point Symbol provides the value of a special data point to the functions it is connected to. The type of 
functions you connect it to depends on the type of object the special thing is. The user identifies the point during GPG 
processing. The user enters the 24 character or less long name, the Value Type, and the Value Source or value. This 
function can be used to access the built-in parameters, special point backdoors, and points and parameters 
already defined by WinPRO when GPG is adding processes to an existing WinPRO configuration. An example of a 
built-in parameter is the N2 communications status point. The 24 character long name would be N2 COMM STATUS. The 
Value Type would be BINARY and the Value Source would be PARAM. Typical WinPRO points would be:

24 char.  Value Type  Value Source
name       FLOAT        INPUT          for analog input points (AI)
name       FLOAT       OUTPUT       for analog output points (AO)
name       BINARY      INPUT          for binary input points (BI)
name       BINARY     OUTPUT        for binary output points (BO)
name       FLOAT       PARAM         for analog parameters (AD)
name       FLOAT       RESULT        for analog results (Monitor only AD)
name       INTEGER   PARAM         for integer parameters (ID)
name       INTEGER   RESULT        for integer results (Monitor only ID)
name       BINARY     PARAM         for binary parameters (BD)
name       BINARY     RESULT        for binary results (Monitor only BD)



Get the 24 character long name from with-in WinPRO or from the configuration file your adding the process to. If a point 
name has been changed in WinPRO use the original name. You can read the configuration file (*.cfg) with any ascii text 
editor. Do not add GPG processes that command an existing WinPRO generated output point. The processes will have a 
battle. You can use the output points to get the current command to an output if you want to use this as an input to your 
GPG added process. You can have the GPG process change the value of  WinPRO generated parameters if the 
parameters are inputs to the WinPRO process. Things like Occupied Command or Minimum Outside Air Damper Position. 
See the CHUDD example.

Square Root Function                             SQRT

The Square Root function takes a floating point value in at it's left connection and outputs the floating point square 
root of that number to the connection at it's right.

Subtraction Function                              SUB

The Subtraction function subtracts the floating point value from  the bottom left connection from the floating point 
value from the top left connection and outputs the difference on the connector to it's right. It is always used with the two 
input symbol 'L2CON.BMP'. (see example below)



Time Comparision (Time clock) Function  TIMECMP

The Time Compare Function Symbol provides for a time clock function. It is used with the two input symbol, 
'L2CON.BMP' and time type integer parameters. If the current time from the ASC's internal clock is between the start time 
from the top left connection and the stop time from the bottom left connection the binary output provided at the right 
connection will be 'ON' or a '1' value. Otherwise the binary output will be 'OFF' or logic 0. The ASC updates it's internal 
clock setting whenever the ASC is connected to a master on the N2 bus or a device on the Zone Bus connection. The time 
gets reset to midnight whenever the processor in the ASC gets reset. The Zone Terminal keeps the time in the ASC right 
when its connected. If you don't have a ZT connected all the time and you want the ASC to switch occupied-unoccupied 
when off-line it might be best to provide a hardware clock connected to a binary input instead of using this function.

Time Parameter                                      TIMPARM

The Time Parameter Symbol provides for configuring and connecting a time type integer parameter. These 
parameters are usually used for the time functions like Time Compare above. They are configured using hour-minute 
format time. WinPRO converts the value to a special integer value that the time functions understand. The equation 
WinPRO uses to calculate these integers is:      hour X 256 + minute  where hour and minute are 24 hour time format
These parameters can be referenced within other functions by name or can be connected (wired) into the control system. 
Connections can be made to the left or right sides using any of the "connector" symbols. Place a real connector between 
this symbol and function symbols to make a connection. Do not connect directly to point symbols or other parameter 
symbols. To pass the value a function must be used.



Temporary Occupancy Button               TEMPOCC

The Temporary Occupancy Button Symbol provides the status of the Metastat Temporary Occupancy button 
(mapped to BI-5) to the functions it is connected to. It should be connected only to binary (yellow) functions. Below is a 
typical circuit for the temporary occupancy function. The Temporary Occupancy Button Symbol works with UNT and VAV 
controllers but not with AHU controllers. 

Xor Logic Function                                    XOR

The XOR Logic Function Symbol provides a logic Exclusive OR function for two input values. When the  binary 
inputs are different, that is one is 'ON' or logic 1 and the other is 'OFF' or logic 0, the output is 'ON' or logic 1. If both inputs 
are 'ON' or both inputs are 'OFF' then the output is 'OFF' or logic 0. It is always used with the two input symbol 
'L2CON.BMP'. Inputs connect at the left and the logic output is provided at the right connector. Connect to BINARY type 
values.(yellow)

Zone Bus Communications Status Point   ZBCOM

The Zone Bus Communication Status symbol provides a logic point to provide zone bus status. If the Zone Bus is 
communicating the function receiving a connection from this symbol will get an 'ON' or logic 1. If the bus isn't 
communicating the function will get an 'OFF' or logic 0.


